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INTRODUCTION TO SPSS 

What is SPSS?  

SPSS is a Windows based program that can be used to perform data entry and analysis and to 

create tables and graphs. SPSS is capable of handling large amounts of data and can perform 

all type of analyses covered in any Statistics/Economics text book. SPSS is commonly used 

in the Social Sciences and in the business world.  

SPSS stands for “Statistical Packages for the Social Sciences” 

-- It is statistical software tailored to the needs of the social scientists for analyzing the data. 

 --It is more easy and user friendly than other softwares such as STATA, SAS, R etc. 

--Quite useful for beginners 

--SPSS is most widely used software in social science research, market research, 

demographic research etc. 

Opening SPSS  

 Depending on how the computer you are working on is structured, you can open SPSS in one 

of two ways.  

1. If there is an SPSS shortcut like this on the desktop, simply put the cursor on it and double 

click the left mouse button.  

2. Click the left mouse button on the button on your screen, then put your cursor on Programs 

or All Programs and left click the mouse. Select SPSS 14.0, 15.0, 17.0, 20.0 or 22.0.  

Use one of these approaches to open SPSS yourself.  

 Layout of SPSS  

SPSS has mainly three windows which are often used in our research--- Data editor; Output 

viewer and Syntax editor. Many tasks can be performed with the menus and dialog boxes but 

some very powerful features are available only with command syntax. Graphs command is 
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used exclusively in SPSS to make graphs. SPSS usually creates commonly used graphics in 

the fields of social science, such as histograms, scatter plots, and regression line, etc.  

SPSS Program Windows 

(1) Data Editor- i. Data View, ii. Variable View 

(2) Output Viewer 

(3) Syntax Editor 

(4) File Types 

– Data: filename.sav 

– Output: filename.spo 

– Commands: filename.sps 

• Menus and Toolbars 

Data Editor Window 
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Output Window 

 

 

Data Editor  

The Data Editor window has two views that can be selected from the lower left hand side of 

the screen. Data View is where you see the data you are using. Variable View is where you 

can specify the format of your data when you are creating a file or where you can check the 

format of a pre-existing file. The data in the Data Editor is saved in a file with the extension 

.sav.  

Output Viewer  

The other most commonly used SPSS window is the SPSS Viewer window which displays 

the output from any analyses that have been run and any error messages. Information from 

the Output Viewer is saved in a file with the extension .spo. Let‟s open an output file and 

look at it. 



6 
 

Syntax Editor  

This screen must be opened from the Data Editor menu by clicking on File, New, Syntax 

and allows for program writing. It will allow saving of a series of functions as a program 

that will run on different data sets. The Syntax editor can save time on running a program 

such as categorizing z-scores, calculating tables for behavioral habits, etc by simply saving 

them as programs and running them on the new data base with just a few adjustments to 

variable names. The syntax editor can be written into directly or functions can be pasted 

from the data editor menu (this is the easiest method). The syntax editor is identified by the 

name in the upper left of the screen, for example: Syntax 1 –SPSS Syntax 

Running the SPSS commands in the Syntax Editor window 

 

Once you have created any SPSS command lines in the Syntax Editor window, you can run 

ALL of the commands or run a selection of commands at any time. 

 1. To run all of the commands in the window: Go to the menu "Run" on the top of the Syntax 

window, choose "ALL" to run all commands. The results will appear in the Output Editor 

Window. 
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PRIOR EXERCISE BEFORE DATA ENTRY 

Survey data which are collected from field require certain operations before it can be 

used for analysis. 

The operations are: 

  i) Define variables name 

  ii) Editing 

 iii) Coding 

 iv) Preparation of codebook  

EDITING 

Editing means checking the schedules for completeness, accuracy, and uniformity  

• Completeness: To check that whether there are answers for every question. 

• Accuracy: Answers are correctly filled-in. It is not enough to check that questions are 

answered. But one must try to check that the answers are accurate. 

• Uniformity: To check that investigators have interpreted questions and instruction 

uniformly.       

CODING 

Coding is a process by which questionnaire entries are assigned to a numeric code: 

 Number Question: This can be coded as the same way as it has been recorded of the 

questionnaire at the time of interview. 

            Example: Age, No. of children. 

 Fixed Alternative Questions: Questions of this type are YES/NO, SEX, Month etc. 

(The number of alternatives decided in advance). 

 Semi-Open-ended Question: Questions with fixed number of alternatives plus an 

„OTHER‟ option.  

                 Example: Other contraceptive methods 
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Open-ended Questions: These questions are left commonly open for the interviewers, and 

no alternative are suggested in the questionnaire. The reason for this may be either of the 

following: 

        i) Too many alternatives: Occupational Status 

        ii) The response cannot be foreseen: Reasons for not seeking treatment 

Multi-coded Question: Multi-coded questions belong to the group of „fixed alternative‟ 

questions, as the number of possible replies are fixed. However, in multi-coded questions, the 

answers are not mutually exclusive, so that one or more answers are allowed for the same 

respondents  

DESCRIPTION OF COLUMNS 

Name of variables: In name column we enter the name of respective variables. Variable 

name must  starts with a letter and other characters can be any letter, digit, a period or any 

symbols such as @, #,_, $.   

However the name could not be end with a period and underscore.  

The lower version of SPSS (v9.0, v10.0, v11.0 etc.) takes only 8 characters but in recent 

version name may be up to 256 characters.  

Type of variable:  The data may be in numeric form or it may be the name (string form). In 

case, if data is in nominal, ordinal, or interval scale then we must choose numeric column. 

Width of the variable: In this column we enter the maximum width of response of the 

variables. Means length of character of response. 

  For example:  in case of age the width may be up to 2. 

Decimal: If of the response are in decimal points then we use this column otherwise we keep 

it with 0. 

For example: height in meters, or size of agricultural land. 

Label of variable:  This column provides facility to give the brief description of the variable 
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or for which the name of variables stands. 

 For example: We have variable like, “Type of place of residence” which is assigned the 

name of v101. 

 Then we can give the label like 

Name                        Label 

  v101                       Place of residence 

Note: The variable label may be up to maximum length of 256 characters.    

Values of the variable: The last most important column which indicates the name of 

categories of the variables. 

In case of place of residence there may be two category of values: 

 1-Rural 

 2-Urban   

Missing values:  Missing values are the absence of information with respect to particular 

variable/issue.  

There are two type of missing: 

Missing: In some cases respondents do not provide information of all questions, thus those 

unanswered question is called as missing. We assign 9, 99 and 999 in such case.  

System Missing: In some case respondents are not eligible (skip case) for particular 

question.    

Column: Column format is useful to control the definition of width of columns in the data 

editor and the alignment of data values. 

Column width can also be changed in the data editor by clicking or dragging column borders. 

Changing column width only affects the display of the width, but does not change the defined 

width of variable.  

Measurement: The „measurement‟ column is a specification of variable to identify whether 
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it is scaled or categorical. 

10. Other columns are Align or Role etc.  

Types of Numerical Data 

1. Categorical or Nominal Data / scale 

The simplest way to describe someone is to place the individual in one of a number of 

mutually exclusive categories. For example, a patient‟s blood type; a person can have only a 

particular blood type (with the possible types being O, A, B or AB) or a person‟s birth place; 

one would have born in a particular country only. Data of this type is known as a categorical 

or nominal measurement. The important feature of categorical data is that the categories 

involved are in no sense better or worse or bigger or smaller, than one another. They are 

simply different from one another. 

 Nominal data that take on one of two distinct values- such as male and female- are said to be 

dichotomous or binary. It is a special type of categorical measurement in which only two 

categories exist. A librarian‟s gender is a classic example of this, as is perhaps the ultimate 

binomial variable, whether an individual is alive or dead. 

Because the various categories in a categorical variable are simply different from one 

another, it makes no sense to try to take average or combine them. The idea of an average 

gender is of course quite nonsensical. Individuals are either male or female, and there simply 

is nothing in between the two. Example: 51 % are male in this seminar hall.  

2. Ordinal Data/ scale 

When the order among categories becomes important, the observations are referred to as 

ordinal data. For example, A student‟s performance in the exam can be ordered as: very 

good, good, poor, and very poor. There is no built-in-guarantee that the magnitude of change 

between very good and good is the same as the change between poor and very poor. 

 



11 
 

3. Ranked Data 

 In some situations, we have a group of observations that are first arranged from highest to 

lowest according to magnitude and then assigned numbers that correspond to each 

observation‟s place in the sequence. This type of data is known as ranked data. As an 

example, consider all possible causes of death in Mumbai. If the causes are ordered from the 

one that resulted in the greatest number of deaths to the one that caused the fewest and then 

assigned consecutive integers, the data are said to have been ranked. 

4. Discrete Data 

For discrete data, both ordering and magnitude are important. In this case, the numbers 

represent actual measurable quantities rather than mere labels. In addition, discrete data are 

restricted to taking on only specified values-often integers or counts-that differ by fixed 

amounts; no intermediate values are possible. For example, number of times a woman has 

given birth. Note that for discrete data a natural order exists among the possible values. If we 

are interested in the number of times a woman has given birth, for instance, a larger number 

indicates that a woman has had more children. 

5. Continuous data 

Data that represent measurable quantities but are not restricted to taking on certain specified 

values (such as integers) are known as continuous data. In this case, the difference between 

any two possible data values can be arbitrarily small. For example, time, temperature, 

concentration of a pollutant. In all instances, fractional values are possible. Some times we 

might require a lesser degree if detail than that afforded by continuous data; hence we 

occasionally transform continuous observations into discrete, ordinal, or even dichotomous 

ones. 

 Interval scale 

The richest and most sophisticated form of measurement is a process in which individuals are 
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placed on a continuous scale on which the intervals really do have a consistent interpretation 

Example: Individual‟s weight, temperature, blood pressure. Adding one kg to an individual‟s 

weight implies exactly the same amount of weight gain whether the change is from 80 to 81 

kg or from 240 to 241 kg. Measuring individuals on this type of scale called an interval 

scale. It is sensible to talk about average height or weight or age, as it is nonsensical to talk 

about an average gender. 

SORT FUNCTION  

The Sort Sorting involves rearranging subjects and their associated data in order of increasing 

or decreasing values for a chosen variable. One may sort data for a variety of reasons 

including the need to easily find particular data points and to make any gaps in the 

progression of continuous data values evident. Most researchers do not sort data by hand 

because, especially with large data sets, doing so takes a very long time. However, SPSS can 

sort data within a matter of seconds. SORT CASES first sorts the file according to the first 

variable that is named. For subsequent variables, cases are sorted within categories of the 

previously named variables. 

The process of sorting data in SPSS requires five steps.  

1. Begin by selecting Data from the options at the top of the Data View or 

Variable View screen. A pull-down menu should appear.  

2. From the pull-down menu, select “Sort Cases.” A new window entitled Sort 

Cases should appear. 
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3. An untitled box in the Sort Cases window contains the names of all variables 

for which data exists in the file. Indicate the variable that should serve as the 

basis for sorting by clicking on its name and clicking on the arrow to the right 

of the box. The name of the variable should move from its original position to 

the box labeled “Sort by.”  

4. If necessary, change the designation in the “Sort Order” box from ascending to 

descending. 

5. Click “OK.” 

      Upon completing this process, the Data View screen should reappear with data 

sorted according to the values of the variable specified.  
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Limitations 

 You cannot specify more than 64 sort variables. 

THE FILTER FUNCTION 

The Data option at the top of the Data View and Variable View screens also contains the 

command to filter data.  

The following steps present the process for doing so.  

1. Begin by selecting Data from the options at the top of the Data View or Variable View 

screen. A pull-down menu should appear.  

2. From the pull-down menu, select “Select Cases.” A new window entitled Select Cases 

should appear 

3. Click on the “If” button located under the “If condition is satisfied” prompt located in the 

“select” portion of the box. Another window, entitled Select Cases :If, should appear. 
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4. An untitled box in the Select Cases: If window contains the names of all variables 

for which data exists in the file. Indicate the variable that should serve as the basis 

for filtering by clicking on its name and clicking on the arrow to the right of the 

box. The name of the variable should move from its original position to the box on 

the right.  

 

5. Use the keypad located in the Select Cases: If window to describe the values of the 

selected variable that should remain. For example, a researcher who wishes to omit subjects 

with “age less than 30 years” from subsequent analyses would select click on the “>” and the 
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“30” buttons. A mathematical statement identifying the selected values for the filter variable 

(e.g. age > 30) should appear in the box above the keypad.  

6. Click “Continue” to return to the Select Cases window.  

7. Click “OK.”   

Upon completing this process, the Data View screen should reappear. Diagonal lines through 

case numbers identifies the data to eliminate from subsequent analyses. Also, a new column, 

entitled “filter_$ should appear. This column assigns values of 0 to cases that SPSS has 

“filtered out” and 1 to the cases that remain.  

 Also multiple “if condition” can be applied simultaneously for data analysis.   

To remove the filter, the user need only choose the “All Cases” option from the “Select” 

portion of the Select Cases window.  

 

SELECT CASES 

SPSS allows us to select part of the data set for further analysis, while excluding the 

remaining cases from these analyses. The procedure is found by choosing Select from 

the Data Menu.  
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We then have several "Select" options within the dialogue box that comes up so we 

can tell SPSS which data to select and which to ignore. The select dialogue box 

looks like this: 

 

First, we have to specify how to select data and which data to retain for the analyses: 

 All cases 

This option actually turns off any previous selection and uses all data in the file. Click 

on this radio button and then click on the OK button. 

 If condition is satisfied 

This option allows us to specify a rule based on values of variables; all cases that meet 

the criteria are retained. After clicking on the radio button for this option, we click on 

the "If..." button to bring up an additional dialogue box sp we can define the rule or 

rules for including or excluding data: 

We also have to tell SPSS what to do with the unselected data. SPSS can either filter it or 

delete it. If we choose to delete the unselected data, those cases not meeting the criteria 

specified above will be deleted and cannot be recovered! If we choose to filter the 

unselected data, then the data will not be deleted, but SPSS will ignore the data in any and all 
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analyses until the filter is "turned off" by selecting the All cases option described above. This 

filtering option, therefore, is far safer than the deleting option. 

THE SPLIT FILE FUNCTION 

With SPSS‟s split file function enabled, SPSS executes all commands separately for each 

category of a particular variable. Researchers should use the following procedure to split a 

file.  

1. Begin by selecting “Data” from the options at the top of the Data View or Variable View 

screen. A pull-down menu should appear.  

2. From the pull-down menu, select “Split File.” A new window entitled Split File should 

appear.  

 

 

Select “compare groups” from the options in the center of the Split Files window. The 

originally faded box marked “Groups Based on,” should become clearly visible.  

4. An untitled box in the Split Files window contains the names of all variables for which 

data exists in the file. Indicate the variable that should serve as the basis for splitting the file 
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by clicking on its name and clicking on the arrow to the right of the box. The name of the 

variable should move from its original position to the box marked “Groups Based on.”  

5. Click OK.   

 

output will be like this 
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Upon returning to the Data View page, the user sees no immediate evidence of splitting a file, 

as he or she sees after sorting of filtering data. The results of having split a file do not become 

apparent until the user creates SPSS output, when he or she can see separate statistics or 

graphics for each identified category of subjects.   

To disable the split files, command, the user must revisit the Split File window to instruct the 

program to analyze all cases of the data. Also, for good measure, the user should remove the 

name of the variable that served as the factor for splitting the file from the “Groups Based 

on” box, by highlighting its name and clicking on the arrow the left of the box.  

If you Select “organize output by groups” from the options in the center of the Split Files 

window. The originally faded box marked “Groups Based on,” should become clearly visible.  

 

Then the output will be like this 
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RESTRUCTURE 

Below are two different ways to set up repeated measures data, namely, the long format and 

the wide format. The long format uses multiple rows for each observation or participant: 
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This example data contains two participants measured on two outcome variables (weight and 

calories), under three different time points. 

You can convert data structures by using the point-and-click function in SPSS. 

To restructure data from wide format into long format in SPSS, using the sample data above: 

1. From the Data tab, select Restructure.  

 

2. In the Restructure window, select Restructure selected cases into variables, and 

then click next.  

3. Under "Case to Variables: Select Variables", enter ID in the identifier variables box, 

and then click next.  

4. Under sort to current data select „yes‟ and then click next.  

5. Under "Order of New Variable” select “Groups Group by Index” and then 

click next and Finish. 
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RECODING 

Recode is one of the transformation functions 

-- It modifies data values by recoding 

--  It is used to combine the categories 

-- To change the values of an existing variable 

-- To create a new variable based on the values an existing variable 

  Two type of recoding Options 

(1) Recode into the same variable 

(2) Recode into a new variable -Important 

Recode Procedure 

Recode into New Variable  

• In the menu, click Transform -> Select Recode -> Into Different Variable(s) 

• Select and move variable(s) over. 

• Name and label of the new variable. 

• Click, Old and New Values 
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• For each value of the existing variable 

• Enter the old value 

• Enter the new value 

• Click Add 

• Repeat for each value or range of values 

•  Click Change 

•  Click OK 

Example 
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COMPUTING 

Computing new variables 

• It is performed by calculations with a variable and a function 

 In some cases, you might want to calculate new variables based on values in existing 

variables and some arithmetic function like multiplying or dividing. For example, if you have 

a variable that contains an annual salary, you might want to calculate a monthly salary. To 

create the new variable, you use the Compute function. 

It’s Use 

• We can create new variables or replace the values of existing variables.  

• For new variables, we can also specify the variable type and label. 

• Compute converts values based on the value of other variables 

• Compute values using logical conditions  

Computation Procedure 

To compute a new variable: 

• In the menu, click Transform 

• To assign a value to the variable, type the variable name in the box labeled  Target 

Variable 
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Example 

 

MERGING DATA FILES IN SPSS 

There are times in applied research when the necessary information needed for an analysis 

resides in two more data sets. The solution to this problem is merging the relevant data sets 

together. This can be accomplished in SPSS using the Data menu choice. There are three 

types of merging that SPSS can carry out: (1) adding cases; (2) adding variables; and (3) 

transposing the data set. We will look at the first two of these one at a time.   

Adding Cases  

Adding cases merges the active dataset with a second dataset or SPSS-format data file that 

contains the same variables (columns) but different cases (rows). For example, you might 

record the same information for subjects in two different schools and maintain the data for 

each school in separate files. The second dataset can be an external SPSS-format data file or a 

dataset available in the current session.  

Unpaired Variables  

Unpaired variables are variables to be excluded from the new, merged data file. Variables 

from the active dataset are identified with an asterisk (*). Variables from the other dataset are  

identified with a plus sign (+). By default, this list contains:  
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• Variables from either data file that do not match a variable name in the other file. You can  

create pairs from unpaired variables and include them in the new, merged file.  

• Variables defined as numeric data in one file and string data in the other file. Numeric 

variables cannot be merged with string variables.  

• String variables of unequal width. The defined width of a string variable must be the same 

in both data files.  

Variables in New Active Dataset  

Variables to be included in the new, merged data file are by default all of the variables that 

match both the name and the data type (numeric or string) are included on the list.  

• You can remove variables from the list if you do not want them to be included in the 

merged file.  

• Any unpaired variables included in the merged file will contain missing data for cases from  

the file that does not contain that variable. 

You have two data files.  Each case in the one file corresponds to one case in the other file.  

In both files each case has an identifier, and the identifiers match across cases.  You want to 

match up records by identifiers. 

First, you must sort the records in each file by the identifier.  This can be done by clicking 

Data, Sort Cases, and then scooting the identifier into the “Sort by” box, OK. 
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I have used an alphanumeric identifier here, but usually I use a numeric identifier.  The 

syntax for the sort is: 

SORT CASES BY 

  ID (A) . 

 Bring the one file into SPSS.  Here I use the file Merge1.sav. 

 

 

 Click Data, Merge Files, Add Variables.   

 

 

If the other file is open in SPSS you may select it from the box under “An open dataset.”  In 

this case the second file is not open, so I Browse to select it. 
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 Continue. 

 

 

Select “Match cases on key variables in sorted files” and “Both files provide cases.”  Scoot 

the identifier (ID, which was in the Excluded Variables box) into the Key Variables box.  

OK. 



30 
 

 

TRANSPOSE 

Transpose creates a new data file in which the rows and column in the original data file are 

transposed so that cases (rows) become variables and variables (column) become cases. 

Transpose automatically creates new variables names and displays a list of the new variable 

names. 

To transpose variables and cases 

From the menus choose: 

Data 

Click on transpose 
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Select one or more variables to transpose into cases (to select all the variables you can press 

ctrl+A, so all the variables will be selected) , Put into variable box 
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click on OK. 

VISUAL BINNING 

 You need to create a new variable that represents the class intervals for the grouped 

frequency distribution. One way to do this is with the Visual Binning function in SPSS.  

From the menu bar, select Transform, Visual Binning.  

 

Scoot the variable of interest into the “Variables to Bin” pane. 
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 Click Continue. 

 

Provide a name for the binned variable.  

SPSS has already provided you with one cutpoint, HIGH.  



34 
 

You provide the others.  

Put the cursor in the row below high and enter a new cutpoint. 

Move the cursor to the bottom row of the grid, enter another new cutpoint and hit Return. 

When you can finished entering cutpoints, you click on “Make Labels.” 

Finally satisfied with the binning, I click OK. 

 

On the next page are a frequency distribution table and a plot for the binned variable. To 

produce these, click Analyze, descriptive statistics, frequencies. Scoot the binned variable to 

the right, select the desired options, and OK. 

AGGREGATE DATA 

Aggregate Data aggregates groups of cases in the active dataset into single cases and creates 

a new, aggregated file or creates new variables in the active dataset that contain aggregated 

data. Cases are aggregated based on the value of one or more break (grouping) variables. 
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First click on the “Data”  

Choose “Aggregate” option   

 

If I wanted to compute mean income according to religion, then put only categorical or 

nominal variable like religion in the box of break variable 

And continuous variable like income in the summaries mean  
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click on function select the mean 

 

click on continue  

click ok 

now click on the data view  
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New variable “income_mean” has been generated in the data set. 

Now you can run the frequency of new variable “income_mean” 

Reading Data from a Text File 

From the menus choose: 

File > Read Text Data...  

 

Select Text (*.txt) as the file type you want to view. 
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Step 1, you can choose a predefined format or create a new format in the wizard. Select No to 

indicate that a new format should be created. 

► Click Next to continue 

 

Step 2 

► Select Delimited to indicate that the data use a delimited formatting structure. 

► Select Yes to indicate that variable names should be read from the top of the file. 

► Click Next to continue. 
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Step 3 

Type 2 in the top section of next dialog box to indicate that the first row of data starts on the 

second line of the text file. 

 

 

Keep the default values for the remainder of this dialog box, and click Next to continue. 
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Step 4 

The Data preview in Step 4 provides you with a quick way to ensure that your data are being 

properly read. 

 

 

Step 5 

Because the variable names may have been truncated to fit formatting requirements, this 

dialog box gives you the opportunity to edit any undesirable names. 
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Step 6 

Leave the default selections in this dialog box, and click Finish to import the data. 

 

We will get the data 
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WEIGHT CASES 

Weight Cases gives cases different weights (by simulated replication) for statistical 

analysis. 

• The values of the weighting variable should indicate the number of observations 

represented by single cases in your data file. 

• Cases with zero, negative, or missing values for the weighting variable are excluded 

from analysis. 

To apply weight in the data set goes into “data”  

Click in “weight cases” 
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Click on “weight cases by” 

 Scoot the “weight variable” into the “frequency variable” pane. 

 

Click “ok” 

Go to Data Editor Window 

In the bottom bar you can see “weight on” 
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Once you apply a weight variable, it remains in effect until you select another weight 

variable or turn off weighting. If you save a weighted data file, weighting information is 

saved with the data file. You can turn off weighting at any time, even after the file has 

been saved in weighted form. 

If you want to weight off then again go to “data”  

Click on “weight cases” 

Click on “do not weight cases” 

REPLACE MISSING VALUES 

Missing observations can be problematic in analysis, and some time series measures cannot 

be computed if there are missing values in the series. Sometimes the value for a particular 

observation is simply not known. There are different methods to impute the missing values. 

Estimation Methods for Replacing Missing Values 

Series mean: Replaces missing values with the mean for the entire series. 

Mean of nearby points: Replaces missing values with the mean of valid surrounding 

values. The span of nearby points is the number of valid values above and below the 

missing value used to compute the mean. 

Median of nearby points: Replaces missing values with the median of valid surrounding 

values. The span of nearby points is the number of valid values above and below the 

missing value used to compute the median. 

Linear interpolation: Replaces missing values using a linear interpolation. The last valid 

value before the missing value and the first valid value after the missing value are used for 

the interpolation. If the first or last case in the series has a missing value, the missing value 

is not replaced. 
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Linear trend at point: Replaces missing values with the linear trend for that point. The 

existing series is regressed on an index variable scaled 1 to n. Missing values are replaced 

with their predicted values. 

STEP-1: Open the data set and find out that for which variable you wanted to impute the 

missing values. Generally, we are imputing the missing value of continuous variable. In this 

example, the imputation of missing value of income will be displayed. 

GO to Transform and select the replace missing values 

 

STEP-2:  Scoot income variable into the “new variable” pane. In the “Name and Method” 

pane, new variable “income_1” will be displayed and if one wants, can change the name of 

the variable. Click on income_1 and write new name as per your wish and click on change.  
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STEP-3:  Click on method and choose any one appropriate method as described in the 

beginning of this topic. By default, it will show series mean. As per requirement, it could be 

changed to any other method and has been changed to linear interpolation.  

 

STEP-4:  Finally, click on OK. We have successfully imputed the missing values. 
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We can compare the income variable before imputation “income” and after imputing the 

missing values “income_1”. 

INSERT VARIABLES 

At the time of data entry if you have missed to enter any variable then in SPSS 

there is one option to insert variables. 

 

To insert new variables between existing variables 

Go into variable view 
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Select any cell in the variable to the right of (data view) or below (variable view) the position 

where you want to insert the new variable. 

From the menu choose: 

Edit> insert variable 

 

A new variable is inserted with the system-missing value for all cases. 

 

You can change the name of the variable and enter the data case by case. 

CLEAR VARIABLE 

Similarly you can delete any variable from the data set by choosing “clear” option. 
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